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PRIMENA RAČUNARA U ELEKTROTEHNICI

ELEKTRONIC WORKBENCH je program napravljen za analizu različitih 
električnih i elektronskih kola,koji omogućuje korisnicima da kompjuterski analiziraju 
rad uređaja koji ih interesuju.Na primer ,ako je u pitanju audio pojačivač,program 
izračunava i prikazuje jednosmerne i naizmenične napone u svim tačkama,crta 
frekvencijsku karakteristiku i td.

Izgled radne površine programa WorkBench-a dat je na slici:



Prva linija. je linija na kojoj piše ime programa.

Druga linija. Na radnoj površini je MENI BAR koja sadrži nekoliko kartica:

Na primer ako se klikne na Circuit otvara se njen meni:
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BIBLIOTEKE WORKBENCA

Udesnom uglu ekrana je Glavni prekidač i dugme Pause.

U liniji Libraries na slici ispod nalaze se biblioteke sa komponentama elektronskih
uređaja,indikatorima,istrumentima,kontrolnim blokovima i sl.

BIBLIOTEKA SOURCES.

Kada se u liniji sa bibliotekama klikne na biblioteku Sources dobiće se slika:

To je sadržaj ove biblioteke u kome su komponente prikazane kao slike u obliku u kome
će se pojaviti na crtežu
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GROUND.Njime se obeležava referentna tačka u odnosu na koju se mere 
svi naponi.

BATTERY.Baterija,izvor jednosmerne struje čiji je napon konstantan.

DC CURRENT SOURCE.Izvor konstantne jss.bez obzira kolika je otpornost
priključenog potrošeča.

     AC CURRENT SOURCE.izvor konstantne

naizmenične struje AM SOURCE.izvor 

amplitudsko-modulisanog signala
SOURCE.izvor frekvencijski modulisanog signala.

     *Vcc VOLTAGE SOURCE.izvor jednosmernog

napona od 5V. VOLTAGE SOURCE.izvor 
jednosmernog napona od 15V

BIBLIOTEKA BASIC.

Sadržaj ove biblioteke prikazan je na slici:

Specifične komponente su:

Connector-tačka u kojoj se spajaju krajevi više komponenti.Promenljive komponente iz 
biblioteke Basic prikazane su na slici:

FM
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Karakteristična veličina ovih komponenti smanjuje se tako što se na taststuri pritisne 
dirka sa slovom koje se nalazi u srednjoj zagradi u oznaci iznad komponente.Povećanje 
vrednosti vrši se tako što se drži dirka Shift i dirka na odgovarajućem mestu.Na primer

R/1KΩ/50%

Prema ovoj oznaci za pomeranje klizača treba pritiskati R,tada se broj u procentima 
smanjuje(50% pokazuje da je klizač bio na sredini.), a SHIFT i R za povećanje procenta.

BIBLIOTEKA INDIKATORS.

Sadržaj ove biblioteke prikazan je na slici:

1.VOLTMETAR se koristi za merenje jednosmernog napona ili efektivne vrednosti 
naizmeničnog napona između tačaka .Deblja strana pravougaonika oznake voltmetra 
prestavlja negativan priključak.Specifikacija rada postiže se tako što se dva puta klikne 
na sliku voltmetra.Otvara se dijalog Voltmetar Properties

Dijalog ima četri jezička:LABEL...VALUE...FAULT DISPLAY
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MODE(AC ili DC)

2.AMPERMETAR se koristi za merenje jednosmernih struja ili efektivnih vrednosti 
naizmeničnih struja.Priključak spojen sa debljom stranicom je negativan priključak.Ako 
se pri merenju jednosmerne struje pojavi negativan broj,to znači da struja teče u 
suprotnom smeru.

3.SIJALICA je pretvarač el.energije u svetlosnu energiju.Obično su date u programu za 
10W i 12V,ali ove vrednosti mogu da se promene tako što se dva puta klikne na nju.Ako 
je napon koji se dovodi na nju manji od polovine,sijalica ne svetli,ako je veći od 
dozvoljenog sijalica

4.Na slici su(voltmetar,ampermetar,sijalica,crvena sonda,7-C displej,bazer i dekodirani displej.)

5.CRVENA SONDA sastoji se od jedne LED diode i zaštitnog otpornika vezanog na 
red.Jedan kraj te veze spojen je sa MASOM,a drugi kraj je priključak koji postoji na slici 
sonde.Kada se na ovaj kraj dovede pozitivan napon veći od 2.5V,dioda svetli crveno Ako 
je napon manji od 2.5 dioda je ugašena.Sonda se najviše koristi u analizi digitalnih kola
,gde se koristi da se proveri da li je u nekoj tački kola logička jedinica(napon veći od 
2.5V) ili je logička nula.



P a g e | 7

6-BAZER(ZUJALICA) je komponenta koja stvara složeni ton u obliku zujanja. Ona počinje
da svira kada mu se na priključke dovede odgovarajući jss napon. 

BIBLIOTEKA INSTRUMENTS.

Sadržaj ove biblioteke je sledeći:multimetrar...osciloskop...generator funkcija 
ploter

ki analizator...generator reči logički konvertor. 

MULTIMETAR.

Multimetar je instrument koji se najčešće koristi u praksi,jer omogućuje brzo i lako 
merenje struje napona i otpornosti.

logič

Vrsta merenja bira se tako što se klikne na odgovarajuću dugmad(ovde je izabrana 
horizontalna crta simbol za jss)Biranje odgovarajućeg mernog opsega vrši se 
automatski.Pritiskom na dugme Settings otvara se dijalog koji omogućuje da se promene 
otpornosti ampermetra i voltmetra,struju koja prolazi kroz komponentu i sl.
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GENERATOR FUNKCIJE.

Generator funkcije je uređaj koji stvara naizmenične napone:sinusnog,trougaonog i 
pravougaonog NAPONA.

Vrsta napona se bira tako što se klikne na jedno od dugmeta na kome su nacrtani oblici
napona.Učestanost napona može da se menja od 1-999Hz , a amplituda od 1V do 999kV. 

NAPON određenog talasnog oblika dobija se između priključaka + i kraja Common.

OSCILOSKOP.



P a g e | 9

Osciloskop je elektronski uređaj koji omogućuje da se vide talasni oblici napona,kao i da 
se izmere njihove amplitude,učestanosti,fazne razlike i td.

Osciloskop se otvara na isti način kao i predhodni instrumenti.

Kod osciloskopa je najvažnije podesiti:

Time Base(vremenska baza)

Osetljivost osciloskop

Podešavanje TB.

Na slici iznad TB je podešena na o.5s/Div/podeoku/,gde je podeok rastojanje između dve 
uspravne linije.Vremenska baza podešava se prema formuli:

Time Base=1/4f.

.Na primer ako je f=50Hz vrednost TB=1/4*5o=o,oo5s/Div=5ms/Div

Ili ako je f=800Hz vrednost TB=1/4*800=o.3125µs/Div,uzeti prvu veću vrednost od 0.5µs/Div 

Podešavanje osetljivosti kanala osciloskopa.

Na slici gore osetljivost oba kanala podešena je na 5V/Div .gde je podelak rastojanje
između dve horizontalne linije.

U praksi OSETLJIVOST treba podesiti na vrednost: 

OA~Umax/2.
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,gde je OA osetljivost.

Na primer ako posmatramo mrežni napon tada je amplituda napona 
Umax=220*1.41=311V,pa se osetljivost mora podesiti na polovinu od ove vrednosti

155.5V/Div,odnosno njoj najbliža vrednost od 200V/Div. 

Osciloskopom mogu istovremeno da se posmatraju dva napona.

Jedan od njih dovodi se na ulaz u kanal A a drugi na ulaz u kanalB

Pritiskom na dugme Expand dobija se uveličana slika prednje strane osciloskopa,slika iznad. 

Trenutna vrednost amplituda i učestanos pomoću osciloskopa mere se na sledeći način:

Pointer se postavi na mali trougao crvene boje i postavimo ga na određeno mesto,kao na 
slici dole.Taj položaj odgovara vremenuT1=14.7725s a položaj 2 odgovara vremenu 
T2=14.7825.Dakle razlika vremena je T2-T1=10ms,pa je učestanostf=1/10ms=100Hz.
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Slika koja se dobija ne ekranu osciloskopa stalno je u pokretu,zaustavlja 

se sa PAUSE. AMPLITUDA signala dobija se kao Umax=5V/pod*2pod=10V

CRTANJE ELEKTRIČNE ŠEME.

Da bi nacrtali prostu električnu šemu,treba uraditi sledeće: Iz biblioteke Sources klikom 
levog miša prevući iz palete izvor od 12V na radnu površinu,zatim iz biblioteke Basic 
dovedemo otpornik ,a iz.

biblioteke Indikators dovedemo ampermetar.
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Otpornik treba da stoji uspravno,kliknite na njega ,tako da pocrveni,a zatim desni klik i iz 
menija pritisnuti Rotate.

Sledeći korak je povezivanje komponenti.Vrh kursora se postavi na kraj pozitivnog 
priključka baterije,tako da se pojavi mali crni krug.Pritisne se i drži pritisnuto,levo 
dugme.Miš se pomera i pojavljuje se linija,to jest ŽICA.Miš se pomera dok vrh žice 
ne dođe na vrh levog priključka ampermetra,tako da se i ovde pojavi mali crni 
krug.Dugme se otpusti,kosa linija se automatski pretvara u izlomljenu liniju i na 
ekranu je slika:

Klikom na glavni prekidač, ampermetar će da pokaže struju jačine od 12mA,što je tačno i 
po Omovom zakonu:I=U/R=12/10000=12mA,čime smo proverili Omov zakon,slika
dole.
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Nekad se može ukazati potreba da se neki elemenat šeme pomeri,da bi pored njega bio 
postavljen još jedan element.To se radi tako što se kursor postavi na otpornik.pritisne i 
drži levo dugme.Otpornik se pomeri u novi položaj dole(,slika ispod).Ako želimo da 
otpornik od 1kΩ pomerimo na gore,kliknemo na njega i kuckamo strelicu na gore na 
tastaturi.

I žica se može postaviti u novi položaj.Tako se vrh kursora postavi tačno na žicu i 
pritisne,kursor menja oblik u dvoglavu strelicu,pomeramo miša na dole i pustimo 
miša:donja žica je pomerena na dole.

Brisanje komponenti može da se obavi na sledeći način:Pritisne se levim dugmtom na 
komponentu tako da ona pocrveni,pa desnim klikom i iz pomoćnog menija izabrati 
Delete.
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EDITOVANJE KOMPONENTI.

Po difoltu baterija ima napon od 12 V,a otpornik od 1kΩ.Dva puta brzo kliknemo na 
bateriju i na ekranu se pojavljuje Battery Proprerties u kome treb kliknuti na 
Value,obrisati 12 i napisati 24V pa OK.Zatim to ponoviti i za otpornik i podesiti otpor 
na 100 Ω,pa pritisnuti OK.

Klikom na desno dugme 1 u Workbench-u,ampermetar pokazuje novu vrednostost.
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Sada pored svake komponente treba upisati njenu oznaku.Kliknemo dva puta na 
bateriju i u okviruBattery Properties na jezičku Lebel ukucati U1.

Zatim to isto uradimo i sa otpornikom:

Sada je šema kompletirana:
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VEŽBA 1.

Na crtežu sa gornje slike dodaćemo još jedan otpornik i još dva ampermetra.

Ampermetar kroz R1 pokazuje 12mA,a kroz R2 i R3 po 6mA.Dakle važi prvi Kirkohov 
zakon.Proverite šta će se dogoditi ako priključite izvor naizmeničnog napona AC Voltage 
Source .Ne zaboravite da ampermetre prebacite na AC.

KORIŠĆENJE INSTRUMENTA.

U praksi se najčešće koriste MULTIMETAR...GENERATOR FUNKCIJA...i OSCILOSKOP. 

VEŽBA 2.
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MULTIMETAR:

EWB multimetar koristi se na isti način kao i stvarni multimetar.Kada se meri 
napon,njegove sonde,spoje se sa tačkama u kolu,između kojih treba izmeriti 
napon.Kao primer prikazano je kolo u kome se meri napon na potrošaču R3.Pritisnuto 
je dugme V.

Na isti način kako je izmeren napon između tačaka 3 i 4 može da se izmeri napon 
između bilo kojih drugih tačaka.Pošto je napon 3.2727V moguće je naći struju kroz 
otpornik R3: I3=U3/R3=3.27mA

Da bi ovu struju izmerili multimetrom,prebacimo ga na A,raskinemo granu sa otpornikom 
R3 i ubacimo ga u kolo na red sa R3:Ako bi sonde zamenile mesta(donja slika) na 
displeju bio bio negativan broj,što je znak da struja kroz instrument ne teče od plusa ka 
minusu već obratno..
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Redni brojevi čvorova na slikama mogu da se izbrišu,tako što se desnim dugmetom 
klikne na prazno mesto na crtežu.Pojavljuje se pop up meni na kome treba kliknuti na 
Schemetic Options,zatim naShow/Hide i odčekirati Show Nodes.Naizmenični napon i 
struja mere se na isti način ,samo što na multimetru treba kliknuti na dugme sa 
sinusoidom.

MERENJE OTPORNOSTI.

Otpornost se meri tako što se multimetar priključi na bilo kakvu vezu 
otpornika.Multimetrom mogu da se izmere otpornosti samo U KOLIMA BEZ 
NAPAJANJA.U kolu sa slike ekvivalentni otpor možemo naći iz pokazivanja ampermetra 
i vrednosti napona napajanja.

A) 

Re=U/I=2kΩ.
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B)Ako otkačimo napajanje možemo izmeriti diraktno ulaznu otpornost,samo 
moramo pritisnuti dugme na instrumentu Ω.

GENERATOR FUNKCIJA I OSCILOSKOP.

Iz biblioteke Sources dovesti na ekran komponentu Ground ,a iz biblioteke Instruments 
dovesti Function Generator i Oscilloskope i povezati ih prema slici:Na osciloskopu 
podesiti vremensku bazu kanala A na 5ms/Div a osetljivost na 5V/Div.Na isti način na 
generatoru podesiti učestanost na 50 Hz a amplitudu na 10V.Dobićemo sledeću sliku:
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Kada se uključi glavni prekidač pravougaoni impuls se brzo kreće preko 
ekrana,zaustaviti ga sa Pause.Pritisnuti dugme Expand da slika zauzme ceo ekran 
osciloskopa.

Proračun sa dijagrama.

Amplituda signala na ekranu je 2 Div(podeoka),pa je 

U=2Div*5V/Div=10V Perioda T je T=4Div*5ms/Div=20ms 

Učestanost f=1/T=50Hz

AMPLITUDSKI MODULISAN SIGNAL(AM SIGNAL).

Povežite generator AM signala,masu i osciloskop.Podesite vremensku bazu i 
osetljivost kanala na vrednosti sa slike.Uključite glavni prekidač,proširite sliku 
osciloskopa.
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AM signal po difoltu ima Učestanost nosioca od 1000Hz,učestanost modulišućeg 
signala 100Hz i dubinu modulacije m=1.Kliknite dva puta na AM generator i 
podesite dubinu modulacije na m=o.3,slika iznad.

2.primer.

Editujte AM generator da mu učestanost nosioca(Carrier Frequency) bude 684kHz- 
učestanost Radio Beograda,a modulišuća učestanost(Modulation Frequency) 
400kHz,pa podesite osciloskop da se na njemu vidi signal i to:

TB na 2ms/Div

Osetljivost kanala na 2V/Div.

VEŽBA 3.

MERENJE FAZNOG POMERAJA.

Merenje faznog pomeraja između dva napona posmatraćemo na rednoj vezi otpornika i 
kondenzatora.Pošto povežemo šemu,editujemo R i C i podesimo 
instrumente,dobićemosledeću sliku:
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ϕ=ΔT/T*360

Uključimo glavni prekidač i sačekamo nekoliko sekundi,proširimo sliku i 
pritisnemo Pause, da zaustavimo sliku.Postavimo pokazivače kao na slici.

Napon veće amplitude(na krajevima veze) je U, a manji Ucje napon na kondenzatoru.Fazni pomeraj je:
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ϕ=125*10-9/10-6*360=45

ΔT=125nsT=1/f=1/1MHz=10 -6..sa dijagrama gore.

Dakle fazni pomeraj između napona U i napona Uc iznosi 45 stepeni. 

VEŽBA 4.

DC OPERATING POINT.

Predstavlja analizu jednosmernog režima.Kao primer prikazano je jedno električno kolo 
koje se sastoji od generatora jednosmernog napona od 12 V,osamo otpornika ,kalema i 
kondenzatora.

U malim pravougaonicima su redni brojevi čvorova.Ako ih nema koristite 

komandu: Circuit>Schematic Option>Show/Hide.

A sada otvorite meni Analysis.
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Pritiskom na glavni prekidač pojavljuju se rezultati analize:
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U koloni Node/Branch su brojevi čvorova i oznake grana,a u koloni Voltage/Current
veličine napona čvorova i struje u granama.Svi naponi dati su prema masi

PRORAČUN STRUJA KOLA.

I1=U1-U2/R1=12- 

6/1000=6mA I2=U2- 

U3/R2=6-3/1000=3mA 

I3=U3/R3=3/1000=3mA 

I4=U2-U7/R4=6- 

2/1000=3mA I5=U3- 

U5/R5=3-3/1000=0mA 

I6=U5/R6=3/1000=3mA

I7=U6/R7=0/1000=0mA(u grani sa C nema 

struje) Il=OmA(kalem se ponaša kao  

kratki spoj)

Ekvivalentni otpor kola može se naći kao: Rekv=U1/I1=12/6mA=2000Ω 

VEŽBA 4.

AMPLITUDSKO FREKVENCIJSKA ANALIZA(AC ANALIZA).

Na slici je prikazana šema po kojoj se u laboratoriji snima zavisnost izlaznog napona 
filtra od učestanosti.Učestanost generatora povećava se u malim skokovima i za svaku 
novu učestanost meri se napon na izlazu.Pomoću dobijenih vrednosti crta se grafik,kod 
koga je na apcisi učestanost .. , a na ordinati veličina izlaznog napona.Učestanost na 
kojoj je U2=0.7 U je GRANIČNA UČESTANOST.Ovo program obavlja veoma brzo.

Nacrtajte kolo kao na slici:
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Otvorite meni Analysis i u njemu kliknite na AC Frequency.Na ekrenu se pojavljuju 
dijalog prozor(slika iznad)Tu su izvršena sledeća podešavanja:

Početna učestanost(FSTART)podešena je na 100Hz

Krajnja učestanost FSTOP) podešena je na 10kHz

U prozoruNODES IN CIRCUIT pojavljuje se spisak svig čvorova u kolu.U
prozor NODES FOR ANALYSIS treba prebaciti potreban čvor,u našem slučaju
komandom add.

Na taj način će zavisnost napona između tog čvora i mase, biti u funkciji

učestanosti izvora. Kliknite na dugme Simulate,otvara se Analysis Graph.
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.VEŽBA 5.

JEDNOSTRANI ISPRAVLJAČ

Na slici je predstavljen ispravljač sa jednostranim usmeravanjem naizmeničnog 
napona.koji obrazuju mrežni transformatorMT,dioda Di kondanzator od 
1000µF.Nacrtajte šemu i editujte komponenta.
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Kliknite dva puta na mrežni transformator..U dijalogu Transformer Propertieskliknite na 
Models pa na biblioteku powrvolt.Oznake svake komponente počinju sa PP.Kliknite na 
onaj sa najpribližnijim karaketistikama,a ako takvog nema ,kliknite na EDIT i unesite 
potrebne vrednosti:

Prenosni odnos 18

RP=26oΩ

RS=4.2Ω

Ukucajte novo ima 220/12 i kliknite na OK

P ppodesite na 300Ω

Vremensku bazu podesite na 5ms/Div

Osetljivost oba kanala na 

10V/Div Uključite glavni prekidač.,i 

zaustavite sliku:

Proverite šta se dešava kada se C! Poveća,a šta kada se smanji-Smanjujte otpornost
potrošača Rp.i posmatrajte pokazivanja ampermetra i voltmetra 

VEŽBA 6.

DVOSTRANI USMERAČ.

Nacrtati šemu dvostranog usmerača i editovati komponente kao na slici.Mrežni 
transformator podesiti na sledeće vrednosti:

Dva puta kliknuti na mrežni transformator.Izabrati PP4-2o,kliknuti na Edit i podesiti

Prenosni odnos na 18,3

RP na 260Ω



P a g e | 29

RS na 4,2

Kliknuti na OK,zatim na Rename,pa ukucati novu oznaku 

MT 220/12 Podesiti vremensku bazu 4ms/Div i osetljivost 

na 10V/Div

Figure

Uključite glavni prekidač,zaustavite sliku I uvećajte je.

VEŽBA 7.RC POJAČIVAČ SA ZAJEDNIČKIM EMITEROM-

Nacrtati sledeće kolo:.
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1.Podesiti generator funkcija da daje sinusni napon amplitude 5mV,učestanosti 1kHz.

2.Snimiti karaktaristiku sa osciloskopa.Vremensku bazu podesiti na 
o.2ms/div,osetljivost kanala A na 2mV/div, a kanala B na 200mV/div.Na osnovu 
dobijenih karakteristika izmeriti kolike su amplitude napona.Podeliti ih i izračunati 
naponsko pojačanje pojačivača.(A=U2/U1)

3. Izvršiti DC analizu i proučiti dobijene rezultate.Na osnovu njih 

izračunati Uce,Ube i Ic. 4.Izmeriti ove napone pomoću DC ampermetra i DC 

voltmetra.

5Uraditi frekvencijsku AC analizu 

kola.: FSTART :10Hz

FSTPO :400kHz

Sweep type

:Decade Number of 

points :100 Vertical 

scale :Linear

Podesiti (izlazni čvor) u prozor Nodes for 

analysis Simulate-

Izbrisati donju sliku,povećati gornju i postaviti rešetku.
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Pročitati izlazni napon(frekvencija signala na ulazu je 1000Hz,naći pojačanje ako je ulazni signal 5mV.

Proceniti na kojoj učestanosti se nalaze granične učestanosti,ako se zna da je na
graničnoj učestanosti izlazni napon 0.707 ulaznog napona.

Menjajte Cul i videti kako utiče na granične 

učestanosti. Podesiti R1=35kΩ i uočiti da je 

izlazni signal izobličen!..

VEŽBA 8.

REDNO OSCILATORNO KOLO.

Nacrtajte kolo sa slike.To je redno oscilatorno kolo koje obrazuje kalem L I kondenzator 
C.Kapacitivnost kondenzatora C1 je 90pF,a kapacitivnost kondenzatora C2 može da se 
menja.Editujte ovaj kondenzator tako da mu kapacitet bude 20pF,a promena 1 %.Na taj 
način dobili ste trimer kondenzator ,čija kapacitivnost može da se menja u granicama 
od nule do 20pF ,u skokovima od 0.2 pF.Smanjenje kapacitivnosti ostvaruje se 
pritiskanjem na taster sa slovom C na tastaturi,a povećanje pritiskom na Shift+C.

Generator funkcija podesiti da daje sinusni napon učestanosti 800kHz,amplitude do 
5V.Startujte AC analizu.Podesite:FSTART na 700kHz FSTOP 900kHz Vertical scale
:linear.Prebacite čvor 4 u desni prozor komandom add,pošto predhodno označite čvor 5 
u levom prozoru,a čvor 1 koji je bio u desnom prozoru izbrišite.Pritisnite SIMULATE-.
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Uvećajte sliku pa kliknite na rešetku da vidite kolika je amplitude napona pri rezonanciji.
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PROTEL 98(EDA/CLIENT 98)

Protel je programski paket koji služi za 
projektovanje ŠTAMPANIH PLOČICA.Štampana ploča je ploča presvučena tankim slojem 
bakra.Na bakarnom sloju projektuju se štampane veze(provodnici),između komponenti koje 
se lemljenjem pričvršćuju za pločicu.Gotov plan štampanih veza i položaj komponenti se 
odštampa na pausu,odakle se kasnije posebnim postupkom prebacuje na bakarnu 
pločicu.Prema broju provodnih slojeva razlikujemo:JEDNOSLOJNE,DVOSLOJNE ili 
VIŠESLOJNE PLOČICE.U ovom programu uglavnom ćemo se baviti jednoslojnom 
štampom:sa gornje strane pločice biće smeštene komponente,a sa donje strane štampane 
veze.

STARTOVANJE PROGRAMA:
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Program se pokreće klikom na ikonicu :

Uvodni ekran sadrži:

1.PANEL SA BIBLIOTEKAMA

2.PROJEKT MENAGER

3.RADNI PROZOR

4.LINIJA MENIJA

5.PALETA SA ALATOM

6.STATUSNA LINIJA

7.KOMANDNA LINIJA

Klikom na određeni jezičak EDA EDITOR TABA aktiviraju se sledeći programi:

PCBProgram za PROJEKTOVANJE ŠTAMPANE PLOČICE

PCB lib..........Program za rad sa BIBLIOTEKAMA ELEKTRIČNIH KOMPONENTI.
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Sch .......Program za CRTANJE ELEKTRIČNIH ŠEMA

Sch lib .....Program za rad sa BIBLIOTEKAMA SIMBOLA ELEKTRIČNIH KOMPONENTI.

SERVER ..Definisanje novog servera

SPREAD...Tabelarni prikaz podataka vezanih za projekt

TEXT ..Kreiranje i izmena text dokumenta

WAVE....Program za definisanje signala potrebnih za simulaciju rada električnog kola

SCHEMATIC DOCUMENT EDITOR-SCH
Ovo je program koji služi za crtanje električnih šema na računaru.Objedinjuje rad dva 

programa: 1.Program za crtanje električnih šema

2.Program za kreiranje novih i zamenu postojećih električnih komponenti u 

bibliotekama. Startovanje SCH programa sa Editor EDA TABA:
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Otvara se radni list sa propratnim radnim okruženjem kao na slici.Paleta sa alatom Main 
Toolbar proširen je i sadržajem alatki za otvaranje,snimanje dokumenta,kopiranje i 
premeštanje.Panel sadrži i biblioteke Driving tools i Wiring tools u posebnim 
prozorima.Postavljanjem miša iznad određenih ikonica videti njihov sadržaj.
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CRTANJE ELEKTRIČNIH ŠEMA

Crtanju električne šeme predhodi podešavanja okruženja radnog lista SCH 
editora.Ovo se postiže komandom:Options>Dokument Options:

U dijalog prozoru postavljaju se sledeći 

parametri: STYLE-Standard ili Custom 

OPTIO

NS 

GRIDS

ELECTRICAL 

GRIDS CHANGE 

SYSTEM FONT

Kompletna električna šema sadrži:električne 
komponente,provodnike,napajanje,uzemljenje,čvorove,labele i 
tekstove.

Crtanje električne šeme počinje uzimanjem el.komponente iz aktivne biblioteke i 
postavljanjem u radni list.Aktivna biblioteka je zapisana u prozoru okruženja.Ispod tog prozora 
nalazio se prozor sa sadržajem aktivne biblioteke.
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Formiranje liste otvorenih biblioteka obavlja se na sledeći način:klikne se na dugme
Add/Remove čime se dob ija dijalog prozor Change Library File List:

U gornjoj polovini dijalog prozora bira se biblioteka koja se dodaje na listu otvorenih 
biblioteka,a u donju listi dolazi lista izabranih biblioteka.To se postiže tako što se biblioteka 
odabere i pritisne dugme Add,ili dvostrukim levim klikom miša.Odabraćemo biblioteke

Client\98\Sch98\Library\AMD\Amcodac.lib 

Client\Sch98\Library\Device.lib

Client\Sch 

98\Library\Intel\D.intel.lib

Komponenta se uzima iz aktivne biblioteke tako što se markira ili se klikne na dugme 
Place,ili se uradi dvostruki levi klik na izabranoj komponenti.Pomeranjem miša 
komponenta se dovede na željenu poziciju,a levim klikom miša fiksira na radnom 
listu.Rotiranje komponente vrši se tasterom Space.
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Na slici je prikazano postavljanje otpornika iz Device.Lib sa oznakom RES2 na radni 
list.Otpornik se fiksira levim klikom.Na vrhu kursora se i dalje nalazi otpornik ako je 
potrebno još otpornika.Desnim klikom se završava postavljanje otpornika na radni list.

ELEKTRIČNA ŠEMA REDUKTORA NAPONA

Na slici su postavljene komponente za električnu šemu reduktora napona.

Editovanje podataka vrši se tako što se dva puta klikne na komponentu,ili EDIT>CHANGE 
otvori dijalog prozor PART.U njemu se pod opcijom ATTRIBUTES upisuju sledeći podaci:

LIB RIFime komponente u SCH bibliote ci(automatski se 

upisuje) FOOTPRINT(otisak)-ime komponente u PCB 

biblioteci DESIGNATOR-oznaka komponente na električnoj 

šemi

PART TYPE-Električna vrednost(kataloška oznaka komponente)
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Na slici su prikazani podaci za otpornik RES2.Na radnom listi biće vidljivi samo Designator i 
Part Type.Za primer reduktora napona šema izgleda kao na slici dole

U dijalog prozoru PART moguće je podesiti i:
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Orientation-položaj komponente

X-locationX kordinata položaja komponente

Y-LocationY koordinata položaja

Fill colorboja komponente

Line colorboja okvira komponernte

Pin colorboja priključka komponente

Local coloromogućava izmenu navedenih boja

Foot printovi za reduktor napona AXIALO.4 FUSE...DIODEO.4...SIP2...T1 TO-3 T2 TO-18 C-RADO.4

CRTANJE VEZA IZMEĐU KOMPONENTI

Crtanje provodnika počinje opcijom PLACE>WIRE ili aktiviranjem ikonice iz palete Wiring 
tools-Levim klikom miša započinje crtanje,a završava desnim klikom.Svako skreta nje vrši se 
levim klikom miša.

Editovanje provodnika ostvaruje se dvostrukim klikom na provodnik,čime se otvara dijalog 
prozor Wire u kome se definišu debljina Wire width i boja provodnika Color,a moguće je i 
selektovati provodnik.Posle spajanja svih komponenti dobijena je sledeća šema:
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CRTANJE ČVOROVA

Čvor se može nacrtati opcijom Place>Junction,a mogu se postaviti i 
automatski:Options>Preferences>Schematic>Auto Junction .Posle postavljanja čvorova 
slika reduktora napona dobija konačan izgled.

CRTANJE NAPAJANJA I UZEMLJENJA

C
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Napajanje-uzemljenje električnog kola crta se opcijom PLACE>POWER PORT.Editovanje 
napajanja postiže se devostrukim levim klikom na simbol napajanja,posle čega se izabere 
određeni oblik u dijalog prozoru Power Port.Na slici su prikazani svi simboli za napajanje i 
uzemljenje.

ČUVANJE NACRTANIH ŠEMA

Nacrtana i editovana šema može se sačuvati pod određenim imenom na adresi.

C./Client 98/Sch 98/Examples/ima 

fajla.sch Opcijom File>Save

ZADATAK 1

1.Startovati paket EDA/CLIENT 98
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2.Startovati program za crtanje električnih šema SCH editor.

3.Podesiti

1. Vodoravan položaj radnog lista

2. B format radnog lista

3. idljivost mreže Visible Grid:10 

4.elementarni pomak kursora Snap On:10

5. dejstvo električnog čvora Elerctrical 

Grids:8 4.Aktivirati biblioteku električnih 

simbola Device.lib

5.Nacrtati šemu sa slike,imena u PCB biblioteci(FOOTPRINT) za komponente sa slike su:OS- 
FUSE GREC- FLY4  C1-POLAR1.2  C2-RADO.4   C3-RADO.4   C4-POLARO.6   D- 
DIODEO.4 R-AXIALO.4 IC-TO- 220

6-Šemu snimiti pod imenom Ispravljač.sch u folderExamples:C:/Client98/Sch/Examples/

POVEZIVANJE SCH EDITORA I PCB EDITORA
Pre prelaska u PCB i projektovanje stampne ploće,neophodno je kreirati NET 
listu.Ovo se vrši komandom Tools> Create Netlist.,nakon čega se otvara dijalog 
prozor kao na slici:
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U njoj se podešavaju određeni parametri koji se odnose na format strukturu projekta
,radnje nakon kreiranja net liste.Nakon podešavbanja kao na slici na ekranu se pojavljuje 
sadržaj NET liste,sa ekstenzijom.net.Na slici ispod prikazana je NET lista za REDUKTOR 
NAPONA.net,kreirana za električnu šemu reduktor napona.sch.Net fajl sadrži spisak 
komponenata električne šeme,sa imenima iz PCB biblioteke i električnih veza između 
priključaka(pinova) tih komponenti.Sa formiranom NET listom možemo preći u PCB i 
započeti proces projektovanja štampane pločice.
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PCB EDITOR(PCB)
PCB(Printed Circuit Board) je program pod EDA/Clientom koji služi za štampanje električnih 
pločica.Objedin juje dva programa:

PCB Editor

PCB Library editor 

PCB se startuje na jezičak 

PCB
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Otvara ae radni list C/Client98/PCB-1.PCB sa radnim okruženjem kao na slici.Sačinjavaju ga dva prozora:

Control Panel

Project

Menager Otvorene su

:

Linija menija,paleta alata (Main Toolbar),linija programa (EDA Editor Tabs),statusna 
linija,komandna linija,paleta alata i linija spojeva.
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Linija spojeva nalazi se ispod radnog 
lista(Top,Bot,Tover,KeepOut,Mech1,Multi),predstavlja imena uključenih spojeva.

PODEŠAVANJE RADNOG OKRUŽENJA

Podešavanje radnog okruženja sastoji se od sledećih koraka:

1. Definisanje koordinatnog početka

Ostvaruje se komandom EDIT>ORIGN>SET Koordinatni početak je označen ŽUTIM 
KRUGOM,ukoliko je predhodno uključen Tools>Preferences<Show/hide>Show Orign 
Marker>Ok .Apsolutni koordinatni početak je u levom donjem uglu radne površine,a ako je 
aktiviran neki drugi vraća se sa Edit>Orign>Reset

2. Definisanje slojeva(Layers)

Projektovanje štampane pločice ostvaruje se postavljanjem komponenti na
odgovarajuće slojeve(štampana pločica je višeslojna),komandom Design> Option

Ovde se uključuju potrebni slojevi:

TOP LAYER-je sloj na koji se postavljaju KOMPONENTE i PROVODNICI(štampane veze)
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BOOTOM LAYER-donji sloj pločice na koji se obično postavljaju štampane veze(provodnici)

TOP OVERLAY(ne postoji na štampanoj pločici,služi za lakše i preglednije 
projektovanje,namanjen je za prikaz okvira komponente i teksta uz komponentu)

KEEP OUT LAYER-je sloj za crtanje ivica pločice.Sve komponente i veze moraju biti unutar ivica.

MULTI LAYER-Ovaj sloj se koristi za postavljanje rupa(pad) i prelaza(Via) 

CONNECT-sloj za prikaz linija veza

VISIBLE GRID2-Sloj za prikaz pomoćne mreže

3. Definisanje boje slojeva 

Definiše se opcijom 

Tools>Preferences

4. Definisanje mernih jedinica i pomoćne 

mreže U PCB se koriste dve merne jedinice MILS 

i MILIMETAR 1inc=2.54cm

1mil=0,001inc 

100mil=2.54mm 

1mm=100/2.54=40

mil

1mm=40mils

Merna jedinica se dešiniše u Design>Option>Document option(odabere se Imperial(mil)ili Metric(mm)
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Pomoćna mreža omogućuje lakše postavljanje objekta na radnu površinu.Podešavanje 
dimenzija mreže(stranica kvadrata) vrši se u dijalog prozoru sa aktivnim jezičkom Option,slika 
gore.,pod opcijom Visible 1 ili Visible2.Mreža može biti prikazana punim linijama u opciji Visible 
Kind(lines).ili tačkama u opciji Visible Kind(dot).U istom prozoru definiše se i:

Elementarni pomak kursora opcijom Snap

Električna mreža pod opcijom Electrical grid(enable)

Područje delovanja čvora pod opcijom Electrical Grid>Grid Range

DIMENZIONISANJE PLOČICE

Stvarna veličina pločice zavisi od broja i veličine komponenti koje se na nju 
postavljaju.Dimenzije pločice izražavaju se u inčima ili milimetrima.Pločica se crta u Keep Out 
Layer-u ,komandom Place
>Track.Aktiviranje sloja vrši se levim klikom na istoimeni jezičak koji se nalazi u liniji slojeva 
Keep Out Layer.Početak i kraj linije se potrvđuje pritiskom na levi taster miša.Nacrtani okvir 
pločice uvećava se- (umanjuje)tipkama Page up i Page Down ili sa View>Zoom in>Zoom 
Out ili lupama + ili -.

Za ilustraciju projektovanja štampane pločice,poslužićenšema Reduktora 
napona.Dimenzionisanje i ctranje pločice veličine 3000x2000mils(75x50mm) prikazano je 
na slici.Radi preglednosti koordinatni početak(X:0,Y:0) postavljeno je na mesto koje 
pokazuje kursor na slici:
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UČITAVANJE NET LISTE

Pre učitavanja NET liste MORA BITI AKTIVNA BIBLIOTEKA SA POTREBNIM KOMPONENTAMA IZ 
PRIMERA
A TO JE BIBLIOTEKA ADVPCB.LIB,koja se nalazi na adresi C:/Client98/PCB/Library,na 
isti način kao i u SCH Editoru komandama Design>Add/Remove Library.Ako se u 
projektovanju poločice koriste komponente i iz drugih biblioteka,potrebno je otvoriti i te 
biblioteka.Učitavanje NET liste vrši se komandom:

Design>Netlist otvara se prozor Load/Forward Annotate Netlist
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Klikom miša na Browse bira se određena NET lista.Sam program traži komponente za NET 
listu(Footprint)u PCB bibliotecii učitava veze između priključaka Pad-ova i Nod-ova.Lista 
sadrži spisak svih učitanih i neučitanih komponenti i veza.Neučitane komponente i veze 
označene su kao greške Error.

KOMPONENTA neće biti učitana ako se dodeljeno ime Footprint komponente ne nalazi u PCB 
biblioteci,i toiz sledećih razloga:

Greška u pisanju(pogrešan karakter)

Dodeljeno je nepostojeće ime u PCB bibluioteci

Veze neće biti učitane ako imena priključaka u PCB (Pad,Nod)nisu INDENTIČNE.

PRIMER1:

Pri učitavanju reduktor napona .netformirana je lista u prozoru iznad.U listi su zabeležene sve greške
,koje su se javile pri učitavanju komponenti i njihovih veza.Vidi se da su sve komponente 
sadržane u ADVPCB biblioteci učitane.ispravni Footprintovi,ali da nedostaju veze,koje nisu 
učitane zbog različitih imena priključaka komponente u SCA(to su priključci emitter,base i 
collector),u odnosu na iste u PCB(1,2,3)

KOREKCIJU moramo izvršiti u Netlist Macros listi zamenom priključka.

To se u našem primeru vrši dvostrukim klikom miša na T1-COLLECTOR i u novom 
prozoru NETLIST MACROS briše naziv COLLECTOR i piše broj 3.Isti postupak važi i 
za ostale priključke tranzistora.
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Nakon ispravke svih grešaka aktivirati taster EXECUTE.Ovim se sve komponente 
prenose na pločicu.Veze između priključaka raznih komponenti(PADOVA) prikazane 
su pomoćnim vezama.

RAZMEŠTANJE KOMPONENTE NA PLOČICI

Rayme[tanje komponenata vr[i se ručno ili automatski.Automatsko razmeštanje aktivira se komandom:

Tools>Auto place.Izvršenjem ove komande kreira se dokument Place_1.Plc na slici 
ispod.On predviđa optimalan raspored komponenata na pločici.Ovakvih dokumenata može 
se napraviti više,pa potom odabrati najpogodniji.Za šemu reduktora napona na slici ispod 
prestavljena je šema automatskog razmeštanja,a ako se ponovi postupak dobiće se novi 
raspored i novi dokument:
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UNOŠENJE ODABRANOG RASPOREDA NA PLOČICU VRŠI SE KOMANDOM Update PSB iz File menija
Global Placer Server(kada je aktivan Plc dokument.Rezultat unošenja za reduktor 
napona iz dokumenta

Place-1.Plc izgleda kao na slici ispod:
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Ručno razmeštanje komponenti vrši se komandom Edit>Move>Component levim 
klikom miša na komponentu koju treba premestiti na drugo mesto ili prevlačenjem 
komponente pomoću miša.Komponenta se rotira tasterom SPACE

RUTIRANJE-IZVLAČENJE ŠTAMPANIH VEZA

Crtanje veza obavlja se u Bottom Layer-u za jednoslojnu štampu .Ova aktivnost se može 
obaviti automatski i ručno.

1.AUTOMATSKO RUTIRANJE

Pre rutiranja potrebno je zadati određena pravila crtanja raznih objekata na projektu štampane 
pločice. komandom Design>Rules posle čega se otvara dijalog prozor Design Rules 
(ispod)u kojem definišemo pravila crtanja.Ovde su navedena neka:

Clearance Constraintdefinisanje minimalnog rastojanja između komponenti 
Pad,Via,Track na nekom sloju

Routing Cornersdefinisanje pravila za crtanje uglova pri izvlačenju veza- 

Routing Layers definisanje načina korišćenja sloja(ako se koristi) pri rutiranju 

koje može biti Horizontalno ili vertikalno.
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Routing Prioritydefinisanje prioriteta crtanja od 0 do 100

Routing Topologydefinisanje načina povezivanja priključaka.Praktikuje se da veze između pinova 
budu što kraće.

Routing Via Styledefinisanje pravila za crtanje Via(njen unutrašnji i spoljašnji prečnik

Width Constraint...definisanje minimalno,odnosno maksimalne 

širine trake Kada se ova pravila rutiranja podese,započinje proces 

rutiranja komandom

Auto Route>All

Sve štampane veze biće izvučene u sloju Bottom Layer(Any),ostali slojevi se ne koriste(not used)
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Za primer reduktora napona iz vršeno je sledeće rutiranje:
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Ostale komande automatskog rutiranja su:

Auto Route>Net....Ovom komandom je potrebno levim klikom označiti pomoćnu vezu,za koju
treba povući štampanu vezu.Izvlači se veza između svih priključaka koji su međusobno
povezani.

Auto Route>Connection

Ovom komandom se povlači štampana veza između dva priključka,ali samo tamo 
gde postoji konekcija(pomoćna veza)
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Auto route>Component

Aktiviranjem ove komande i označavanjem komponenti sa pločice,povlače se sve veze koje 
spajaju ovu komponentu sa nekom drugom komponentom na pločici.

Auto route >Area

Ovom komandom biće izvučene sve štampane veze koje kreću iz priključaka obuhvaćenih blokom:

RUČNO RUTIRANJE
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Ručno izvlačenje štampane veze zadaje se komandom.

Place>Trackali pri tome uvek mora da bude aktivan sloj u kojem se želi štampana 
veza(Botom Layer)Crtanje štampane veze između priključaka je proizvoljno i ne mora 
postojati pomoćna veza

Postavljanje metalizirane rupe Vie

Vrši se komandom:Place>Via

Postavljanje rupe Pada vrši se komandom:

Place>Pad

EDITOVANJE ELEMENATA ŠTAMPANE PLOČICE

Elementi [tampane plo;ice su>

Komponente

štampane veze

rupe

metalizirane rupe

tekst

Editovanje počinje dvostrukim levim klikom na elemenat.
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EDITOVANJE KOMPONENTE

Uključivanjem dugmeta Properties dijalog prozora Compenent mogu se menjati Designator(oznaka 
komonente),Coment(vrednosti) i Footprint(imena u PBC biblioteci)

U prozoru Layer menja se aktivni sloj za komponentu.Zapis koji se odnosi na oznaku odnosno 
vrednost komponente,moguće je menjati samostalno,ako je on vidljiv na pločici(ovo se odnosi 
na bilo koji String).Zapis je vidljiv ako je opcija Hide isklučena.Na slici ispod za Reduktor 
napona komponente su VIDLJIVE.
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EDITOVANJE PAD-A

U otvorenom dijalog prozoru Pad i sa aktivnim dugmetom Prosperties mogu se izmeniti:

Shape .......oblik

Designatoroznaka

Hole size....dimenzija rupe

Layer. .........aktivan sloj
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Rotation. ....položaj..

EDITOVANJE TRAKE

U aktivnom dijalog prozoru Track moguće je podesiti:

Width .......širina trake

Layer. ........aktivni sloj trake

Net..............veze(mrežu)koje gradi traka

Start-X početne X koordinate 

trake Start-Ypočetne y- 

koordinate trake End X završna 

x koordinata trake End –Y 

završna y-koordinata trake.

EDITOVANJE VIA

Aktivno dugme Prospeties u dijalog prozoru Via omogućuje sledeća podešavanja:
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Diametar ......spoljašnjeg prečnika

Hole Size ......unutrašnjeg prečnika

Layer Pair slojeve koja spaja ova metalizirana rupa

X-Location ....položaja po x osi

Y-Location.....položaja po y-osi

EDITOVANJE STRINGA(ZAPISA)

U dijalog prozori String moguće je menjati sledeće parametre:
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Text ........sadržina zapisa

Height.....visina znakova

Width ......debljina znakova

Font .........oblik slova

Layer .......aktivan sloj

Rotation. položaj

X-Locationpoložaj po X osi 

Y-Locationpoložaj po Y osi 

BRISANJE KOMPONENTE

Komponenta se uklanja sa projekta štampane ploćice komandom Edit>Delite 

ZADATAK 1

1.Kreiraj NET listu za Ispravljač.sch
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2.Startuj program za projektovanje štampanih pločica PCB

3.Definiši sledeće radno okruženje:

a)Uključi slojeve Top Layer,Bottom Layer,Top Overlay,Multi Layer,Keep Out Layer

b)Uključi mrežu predstavljenu tačkama na rastojanju od 1000mil 

(Visible Grid 2) v)Uključi električnu mrežu Electrical Grid na 8 milsa

g)Uključi marker koordinatnog početka(Tools>Preferences>Show/Hide>Show 

Orign Marker) d)Za automatsko rutiranje uključi samo Bottom Layer(jednoslojna 

štampa)

4.Proizvoljno postavi koordinatni početak

5.Nacrtaj okvir štampane pločice dimenzije 3000x2000 milsa

6.Učitaj NET listu i ispravi greške

7.Rasporedi komponente prvo automatski po zatim ručno

8. Izvuci električne veze praveći jednoslojnu štampu,samo u Bottom Layeru

9.Štampane veze na štampanoj pločici editovati na debljinu od 25 milsa.Oznake električnih

komponenti učiniti vidljivim.

10. Snimiti štampanu pločicu pod imenom Ispravljač.PCB u folder Examples na adresi:

C:/Client98/PCB/Examples/.

За све недоумице јавити се предметном наставнику на e-mail:
svasilic2020@gmail.com


